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1 - Introduction
ThisGetting Started guide is written for Simplorer beginners aswell as experienced users who are
using Simplorer for the first time.

Simplorer is a simulation package for multi-domain designs that are commonly found in automotive,
aerospace, power electronics, and electric drive systems.

Simplorer provides an approach for the virtual prototyping of large-scale systems by letting you to
develop a design that combines predefined basic and industry-specific components with user-
definedmodels. You can createmodels in common programming languages or standardmodeling
languages such as VHDL-AMS. The basic and industry-specificmodel libraries available for Sim-
plorer provide ready-to-use parameterized components, making Simplorer accurate, and flexible.

l Chapter 2 of this guide shows you how to create and save a new Simplorer project.
l Chapter 3 leads you step-by-step through creating, solving, and analyzing the results of a
Three-Phase Rectifier.

l Chapter 4modifies the example of Chapter 3 by replacing the resistive/inductive load with
a real machinemodel. The example is then expanded to include a control circuit modeled
first using discrete components, then using state graph components.

l In Chapter 5 the state graph controller is replaced with a PI (proportional-integral) con-
troller implemented using block components.

l Chapter 6 substitutes the use of VHDL-AMS opponents for modeling the DC motor.
l Chapter 7 explores several different methods for modeling a PWMController to demon-
strate Simplorer’s versatile modeling capabilities.

l Chapter 8 leads you through the process of importing a legacy Simplorer 7 Three-Phase
Rectifier schematic into Simplorer Release 16.2, saving it, migrating it into Simplorer
2017.2, and then solving and analyzing the translatedmodel.

Overview of the Simplorer Interface
Below is an overview of themajor components of the Simplorer interface.

Simplorer Getting Started Guide
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Project Man-
ager win-
dow and
Project Tree

The Project Manager window shows all the components, models, and other ele-
ments of each design in the project. Each project has its own expandableProject
Tree. Many operations on the design elements can be performed directly from the
Project Manager window.

Message
Manager
window

Displays error, informational, and warningmessages for the active project.

Progress
window

Displays solution progress information.

Introduction 1-2
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Properties
window

Displays the attributes of a selected object in the activemodel, such as the object’s
name, electrical or other associated physical quantities, orientation, and color.

Also displays information about a selected command that has been carried out.
For example, if a circle was drawn, its command information would include the
command’s name, the circle’s center position coordinates, and the size of its
radius.

Design area
window

Displays one or more editor windows such as the Schematic Editor, model editors,
and symbol editor. It also displays various report windows.

Component
Libraries
window

Displays, on the Components tab, the component categories, including Favorites,
Most Recently Used, Simplorer Elements, and Project Components. You can pin
the window tomake it remain visible or make it visible only when it is being used.

The following elements are defined as favorites by default:

l R (resistor)
l L (inductor)
l C (capacitor)
l D (diode)
l E (voltage source)
l AM (ammeter)
l VM (voltmeter)

The Project Components section lists the elements that are active in your projects.

If you have created any personal libraries, a Personal Libraries section displays
them.

The Component Manager window also provides a search feature on the Search
tab.

Menu bar Provides variousmenus that enable you to performSimplorer tasks, such asman-
aging project files, designs, and libraries; customizing desktop components; draw-
ing objects; and setting andmodifying project parameters and options.

Toolbars Provides buttons that act as shortcuts for executing various commands.

Status bar Shows current actions and provides instructions.
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2 - Creating a New Project
This guide assumes that you have installed Simplorer.

In this chapter you will complete the following tasks:

l Create and save a new project.
l Add and rename a Simplorer design in the project.

About the Three-Phase Rectifier
The following example describes a three-phase power supply and a rectifier bridge with res-
istive/inductive load. For the input signals, time-controlled voltage sourceswill be used. The diodes,
the capacitor, and the resistor are ideal components; the diodes are determined by an exponential
function (their characteristic).

Simplorer Getting Started Guide
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Expected Results

After the simulation is run, the results are displayed in Report windows. For example, the first sim-
ulation variation demonstrates these results:

l Voltages of the sources ET1.V, ET2.V, and ET3.V
l Voltage of the smoothing capacitor CD.V
l Current of the load resistor R_LOAD.I

Creating a New Project 2-2
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Using Simplorer to Create and Improve the Design
As you step through thisGetting Started guide, you will be introduced to several key concepts:

l There are numerousways to performmost tasks.

For example, several methods are presented for selecting and for assigning design para-
meter values.

Creating a New Project 2-3
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l There is no required sequence of events when creating a design.— A convenient method
for creating the three-phase rectifier will be demonstrated, but the design setup steps can be
completed in any logical order.

l You can quicklymodify design properties at any time.

For example, you can draw a box freehand, then specify its exact dimensions in theProp-
ertieswindow.

l You can easilymanage your design in the project tree.

The branches of the project tree in theProject Manager window provide access to setup
dialogs, where you canmodify design properties.

l You canmodify themodel view at any time.

Youwill learn shortcut keys likeCtrl+D, which fits themodel in the view window.

l You can save time by parameterizing design properties.

This enables you to quicklymodify design properties and generate new results.

l You can use Simplorer’s extensive post-processing features to evaluate solution results.

Creating the New Project
The first step in using Simplorer to solve a problem is to create a project in which to save all of the
data associated with the problem. A project is a collection of one or more designs saved in a single
*.aedt file. By default, opening Simplorer creates a new project named Projectn and inserts a new
design named Simplorern, where n is the order in which each was added to the current session.

Add the New Project
To add a new Simplorer project:

l ClickFile>New.

Creating a New Project 2-4
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A new project named Projectn containing a new design named Simplorern is added in the
project tree in theProject Manager window.

Hint l If the Project Manager does not appear, clickView>Project Manager.
l If a new design does not appear automatically, clickTools>Options> General
Options. Under Project Options, select Insert a design of type.

l To automatically expand the project tree when an item is added to the project, click
Tools>Options> General Options. Under Project Options, selectExpand Pro-
ject Tree on Insert.

The new project contains a file structure that organizes design elements such as: Ports, Ana-
lysis, Optimetrics, and Results. Project Definitions such asComponents, Symbols, Models,
Packages, Materials, and Scripts are also listed.

Rename the Design
You can rename the default Simplorer design name as follows:

1. Right-click Simplorern in the project tree, and chooseRename on the shortcut menu. You
can also click the name to select it, then pressF2.

This enables the text cursor for the design name.

2. TypeRectifier (or some other name of your choosing), and then pressEnter to complete
the change.

Creating a New Project 2-5
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Add Design Notes (Optional)
You can optionally include notes about your design, such as a description of the design being
modeled, with the project. These notes can be a useful tool for keeping a running log of your
designs.

To add notes to your design:

1. ClickSimplorer Circuit>Edit Notes.

TheDesign Noteswindow appears.

2. Click in the window and type your notes.
3. ClickOK to save the notes in the project tree under the current design.

Note To edit existing design notes, double-clickNotes in the project tree to open the
Design Noteswindow in which you can edit the notes.

Save the New Project
To save the new project:

1. ClickFile>Save.

TheSave As dialog box appears.

2. Use the file browser to find the directory where you want to save the file.
3. Type the desired file name in the File name text box.
4. In theSave as type list, ensure that Simplorer Project Files (*.aedt) is chosen. Simplorer

project files are given an .aedt extension by default.
5. ClickSave to save the project to the specified location.

Note For further information on any Simplorer topic, schematic editor commands or win-
dows, you can view Simplorer‘s context-sensitive online help in one of the following
ways:

Creating a New Project 2-6
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l Click theHelp button in a pop-up window.
l PressShift+F1. The cursor changes to ?. Click on the item for which you
need help.

l PressF1 to open theHelpwindow. If you have a dialog box open, theHelp
window opens to a page that describes that dialog box.

l Use the commands in theHelpmenu.

Now you are ready to create the Rectifier model.
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3 - Create the Rectifier Model
In this chapter you will complete the following tasks:

l Basic Simplorer functions
l Choosing Simplorer components from a library
l Placing and arranging components
l Connecting components on the sheet
l Controlling the display of component properties
l Modeling with electric circuit components
l Modeling time controlled sources
l Setting up and running an analysis (simulation)
l Using Reports for displaying simulation results

Create the Three-Phase Rectifier Schematic
The following example contains a three-phase power supply and a rectifier bridge with res-
istive/inductive load. For the input signals, time controlled voltage sourceswill be used. The diodes,
the capacitor, and the resistor are ideal components; the output characteristics of the diodes are
determined by an exponential function.

Simplorer Getting Started Guide
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Note If youmake amistake, click Rectifier in the project tree, and then clickUndo on theEdit
menu to undo design operations. Simplorer lets you undo every command performed since
the last save.

Choosing, Placing, and Arranging Components on the Schematic Sheet

First, you need to locate and choose the components you want to use in the simulationmodel, and
then place and arrange the components on the schematic sheet.

1. In theComponent Libraries window, select theR: Resistor element. TheR: Resistor
element is listed under Favorites by default.

Create the Rectifier Model 3-2

Simplorer 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Simplorer Getting Started Guide

Note An alternative path is to click the “+” symbol to expand theSimplorer Elements tree, and
then continue to click the “+” symbols next to theBasic Elements folder, theCircuit
folder, and thePassive Elements.TheR: Resistor element is listed under Passive Ele-
ments.
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Note You can also click the toggle triangle at the upper right of the Component Libraries window
to undock the window andmove it to another location.You can also expand the size of the
Component Libraries window.

2. To place the resistor onto the sheet, selectR: Resistor, hold themouse button down, and
drag the selection onto the sheet.

As you drag a library component over theSchematic Editor window, the symbol for that
component is displayed. At this point, you can press theR key to rotate the component
before placing it on the sheet. The component rotates 90 degrees counter-clockwise each
time you press theR key.

3. Release themouse button to place the component on the sheet.

Create the Rectifier Model 3-4
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After placing one resistor, notice that the cursor retains a selected resistor symbol.

This feature permits you to place several instances of a component by clicking without hav-
ing to reselect the component from the library.

4. Right-click to display the short-cut menu for a selected component.

The Finish command exits the “place” mode without placing a component and frees the
cursor for selecting additional library components or other actions.

Create the Rectifier Model 3-5
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ThePlace and Finish command places an additional component before exiting “place”
mode.

Note You can also press theEsc key to exit “place” mode without placing a component.

5. To continue the design, repeat the process outlined above and place the following com-
ponents from theBasic Elements library onto theSchematic Editor sheet.

Module Group Component Quantity
Circuit Passive Elements R: Resistor 4

L: Inductor 4

C: Capacitor 1

Sources E: Voltage Source 3

Semiconductors System Level D: Diode 6

6. When you have placed the elements, use the Three-Phase Rectifier schematic at the start of
this chapter as a guide to arrange the components.

Note Please note the “counting” direction when arranging components. This direction is
marked by the red “dot” or the plus sign on the symbol of electrical components.

Once components are placed, you can select, move, copy, delete, rotate, or flip them. You
can select elements:

l By clicking on them individually.
l By holding themouse button down to draw a selection rectangle aroundmultiple
instances.

l By holding down theCtrl key and clicking onmultiple instances.

Selected instances are highlighted.

Commands for flipping and rotating selected elements appear in the toolbar icons and also in
the schematic editor shortcut menu.

Create the Rectifier Model 3-6
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Hint Save your project frequently: ClickFile>Save.

7. To align specific components, click and hold themouse button, and drag the cursor to specify
a selection area. Selected elements are highlighted.

UseDraw>Align Horizontal to horizontally align the components, andDraw>Align Ver-
tical to vertically align components.

8. A ground node is necessary for each separate circuit on a sheet. To place a ground node,
clickDraw>Ground (or click the ground symbol on the toolbar).

Hint l You can zoom in and out by using theViewmenu commands, the Zoom icon
functions in the toolbar, orCtrl+E (Zoom In) andCtrl+F (ZoomOut).Ctrl+D
(Fit Drawing) scales the drawing to include all of its components in the current
window.

l Tomove the sheet and its contents around within the window, while pressing
Shift, click and hold themouse button (the cursor changes to a “hand” icon)
and drag the sheet to the desired position.

The ground symbol will “stick to” themouse pointer.

9. Position the terminal of the ground node over the terminal of the device you are grounding
and click to place the ground node and connect it to the device. Youmay rotate the ground
node to the desired position if necessary.

Create the Rectifier Model 3-7
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All of the components required for the Three-Phase Rectifier simulationmodel should now be on
the sheet and placed in the appropriate positions. In the next section, you will connect the com-
ponents.

Connecting the Components

When you have arranged all of the components, you are now ready to connect them as required for
this example.

1. To connect components, activate wire drawingmode by choosingDraw>Wire. The cursor
changes to crossed wires.

Note You can also activate wire drawingmode by pressingCtrl+W or simply by placing
your cursor over an element pin (the cursor automatically changes to crosswires)
and clicking on the pin.

2. Connect the components as required for the example circuit.
a. Place the cursor on the element pins and set the beginning, the corners, and the end of a

wire by clicking and dragging.
b. PressEsc to exit wire drawingmode. The cursor changes back to a pointer.

.

Defining Component Properties

The components that you have placed and connected still have their default parameter values, as
defined in theBasic Elementsmodel library. You will now assign values to these components to
match the schematic at the beginning of this chapter by performing the following steps:

1. First, define the parameters of the three voltage sources. All sources are time-controlled sine
function generators with a phase shift of 120 degreeswith respect to each other.
a. Double-click the first Voltage Source symbol to open the component’sParameters dia-

log box.
b. Change theName parameter toET1.
c. Select the Time Controlled radio button and ensure that Sine is selected in the drop-

down list. Keep thePhase value as-is at 0 (zero) degrees. Keep all other values at their
default values.

d. ClickOK to apply the changes.

Create the Rectifier Model 3-8
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2. Double-click the second voltage source symbol to open itsParameters dialog box.
a. Change theName parameter toET2.
b. Select the Time Controlled radio button.
c. Set thePhase value to 120 degrees. Keep all other values at their default values.
d. ClickOK to apply the changes.

3. Double-click the third voltage source symbol to open itsParameters dialog box.
a. Change theName parameter toET3.
b. Select the Time Controlled radio button.
c. Set the Phase value to 240 degrees. Keep all other values at their default values.
d. ClickOK to apply the changes.

Note l Properties of the currently selected element are also displayed in theProp-
ertieswindow similar to the one shown below.

l Many component properties can bemodified in this window. Refer to the
Simplorer help for details.

l Clicking the Info button opens detailed online help for the current com-
ponent.

4. Next, define the parameters of the phase resistors.
a. Double-click the top-most phase resistor symbol to open the resistor’sParameters dia-

log box.
b. Change theName toR_A.
c. Change theResistance from 1000 ohm to 10 mOhm.
d. ClickOK to apply the changes.
e. Repeat steps a through d for the other two phase resistors, naming themR_B andR_C,

respectively.
5. Define the parameters for the phase inductors.

Create the Rectifier Model 3-9
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a. Double-click the top-most phase inductor symbol to open itsParameters dialog box.
b. Change theName to L_A.
c. Change the Inductance from 0.001 H to 0.3 mH.
d. Check Initial Value and set the value to 0 (zero).
e. ClickOK to apply the changes.
f. Repeat steps a through d for inductorsL_B and L_C.

6. Define the parameters of the diodes. In this example, all diodes are staticmodels using an
exponential function as their characteristic.

Note For most applications static semiconductor models supply sufficient simulation data.
If switching, losses, thermal analysis, and other properties are targets of your sim-
ulation, you need dynamic elements. However, usingmany dynamic elements in a
simulationmodel can increase the simulation time.

a. Double-click the upper left diode symbol to open itsParameters dialog box.
b. Change theName toD1.
c. Change the Type by clicking the Type radio button, then choosingExponential Func-

tion from the drop-downmenu.
d. Keep all other values as they are and clickOK to apply the changes.
e. Repeat steps a through d for the remaining diodesD2 throughD6.

7. Define the parameters of the smoothing capacitor.
a. Double-click the capacitor symbol to open itsParameters dialog box.
b. Change theName toCD and change theCapacitance from 1e-006 F to 1 mF.
c. ClickOK to apply the changes.

8. Define the parameters of the load resistor.
a. Double-click the resistor symbol to open itsParameters dialog box.
b. Change the Name toR_LOAD.
c. change theResistance from 1000 ohm to 1.2 ohm.
d. ClickOK to apply the changes.

9. Define the parameters of the load inductor.
a. Double-click the inductor symbol to open theParameters dialog box.
b. Change theName to L_LOAD.
c. Change the Inductance from 0.001 H to 9.5 mH.
d. Check Initial Value and set the value to 0 (zero).
e. ClickOK to apply the changes.

All components of the simulationmodel should now have their correct values. The table below lists
the components of the simulationmodel and their parameter values.
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Name Type Quantities
ET1 Sine

(Time-controlled)

Amplitude [V]=326; Frequency [Hz]=50; Initial Delay [s]=0; Phase
[deg]=0;

Offset [V]=0
ET2 Sine

(Time-controlled)

Amplitude [V]=326; Frequency [Hz]=50; Initial Delay [s]=0; Phase
[deg]=120;

Offset [V]=0
ET3 Sine

(Time-controlled)

Amplitude [V]=326; Frequency [Hz]=50; Initial Delay [s =0; Phase
[deg]=240;

Offset [V]=0
R_A

R_B

R_C

R

(Linear)

Resistance [mOhm]=10

L_A
L_B
L_C

L

(Linear)

Inductance [mH]=0.3;

Initial Current [A]=0

D1…D6 DEXP

(Exponential Func-
tion)

Saturation Current [pA]=1;

Thermal Voltage[mV]=35;

Reverse Resistance[kOhm]=100
CD C

(Linear)

Capacitance [mF]=1;

Initial Voltage [V]=0
R_
LOAD

R

(Linear)

Resistance [Ohm]=1.2

L_
LOAD

L

(Linear)

Inductance [mH]=9.5;

Initial Current [A]=0

Next you will define the component properties that will be displayed on the schematic sheet.

Property Displays for Components

While most component properties are accessible in the dockablePropertieswindow, you control
the display of component properties via theProperty Displays tab in thePropertiesdialog
boxes.
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1. For example, select Voltage Source 1 (ET1) and open itsProperties dialog box. (Right-click
on the component and selectProperties from the context menu.)

2. On theProperty Displays tab, click theAdd button.

This adds a line with three fields:Name, Visibility, and Location. Each of these fields con-
tains drop-down selectionmenus.

l For theName field, select the Label ID of interest.

The drop-downmenu for theName field includes all available property names for the selected
instance. For each kind of component in the schematic, you will select another property value. For
now, start with the name.

l TheVisibility field allows you to specify what to display about the selected Label ID on
the schematic. This can beNone, the propertyName, the property’sValue, theEvalu-
ated Value,Both (the name and value) or Evaluated Both. SelectValue from the
menu.

l The Location field lets you select initial locations relative to the default orientation of the
component instance.

3. For this example, OK the dialog box, and locate and click to select theET1 label in its initial
placement.

Selecting the label highlights it.
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4. Drag the label to a position above the component instance.
5. With the label highlighted, you can click theRotate icon on the toolbar, or useDraw>Rotate

to rotate the label as needed.
6. Open theProperties dialog again, and select theProperty Displays tab again.

Note that the Location field for theName property now showsCustom.

7. Now click theAdd button again.
8. This time, use the drop-downmenu in theName field to locate and selectPHASE.
9. For Visibility, selectEvaluated Both andOK the dialog.

The labelPHASE=0 should now be visible on the schematic.

10. Drag thePHASE=0 label to a position to the left of the component as shown in the figure.
11. Use the foregoing techniques to activate labels for the rest of the components tomatch the

schematic figure.
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l For the Resistors, add “Name” and “R” name.
l For the Inductors, add “Name” and the “L” name.
l For the Diodes, add only “Name” to the display.
l For the Capacitor, add “Name” and “C”.

12. Save your work before continuing to the next step.

Note You can also set the visibility and initial location for properties you wish to display by double-
clicking on a component to open its Parameters dialog box. TheOutput/Display tab has
drop-downmenus for setting theVisibility and Location for each property.
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Specifying Simulation Outputs

During a simulationmany types of data are generated based on outputs that you specify. These
can include quantities such as voltage, current, frequency, phase angle, torque, and displacement.

Using the outputs you define, you can also create reports of simulation results, or plot output quant-
ities specified by probes that you place in the schematic.

To define simulation outputs for the examplemodel:

1. ClickSimplorer Circuit>Output Dialog. This displays theOutput dialog. TheAdd/Re-
move list shows all of the schematic elements. Checkboxes control which quantities are vis-
ible in the selection window.

2. TypeET in the Find field.

Thismoves the displayed list to theET elements, and opens a list of check boxes that show
the kinds of outputs you can select.

3. For ET1, check theV box.

ET1.V is now listed as aDefined Output.

Similarly, check theV boxes for ET2 andET3 to addET2.V andET3.V to theDefined Out-
put list.
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4. Use the Find field to locate theR_LOAD item and check the I box.
5. Use the Find field to locate theCD element, and check theV box.

When you have finished, theDefined Output field will list the items you selected.

6. ClickOK to close the dialog box.

Next, you will define the Solution Options and Analysis Parameters to be used when analyzing the
circuit.
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Defining Solution Options and Analysis Parameters

Simulation parameters control the simulation process. The choice of simulation parameters is
important for a successful simulation. There are general and circuit simulator parameters. The val-
ues obtained during a simulation provide valuable information about the quality of a simulation res-
ult.

To set up solution options:

1. Right-click onAnalysis in theProject Manager window, and selectAdd Solution
Options from the short-cut menu.

This displays theSolution Options dialog box.

2. On the TR tab, change the Integration formula toEuler, theMaximum number of iter-
ations from 40 to 20 and the Local truncation error from 1 to 0.1. Change theName to
ThreePhaseOptions. Leave all other settings unchanged.

3. ClickOK to apply the changes.

An icon for the new options named ThreePhaseOptions appears underAnalysis in the
Project Manager window.

4. Right-click onAnalysis in the Project Manager window, and selectSolution Setup>Add
Transient from the shortcut menu.

This opens a Transient Analysis Setup dialog box.
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5. Change simulationEnd Time from 40ms to 0.1s;Min Time Step from 10us to 1us, and
Max Time Step from 1ms to 0.5ms.

6. Click theAnalysis Options button and select ThreePhaseOptions from theSelect Solu-
tion Options dialog box.

7. ClickOK to close theSelect Solution Options dialog box. ClickOK again to close the Tran-
sient Analysis Setup dialog box.

Now that you have set up the necessary conditions for finding solutions for the example circuit, the
next step is to start an analysis.

Starting an Analysis

To start an analysis:

1. Start the analysis (simulation) by selecting theSimplorer Circuit>Analyzemenu com-
mand.

You can also right-click onAnalysis in theProject Manager window and clickAnalyze on
the short-cut menu, click theAnalyze icon on theSimplorer Simulation toolbar, or press
F12 on your keyboard to start the analysis.
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The simulationmodel is compiled and outputs are calculated. During the simulation run, the
name of themodel is visible in the simulation toolbar in theProgresswindow, and a button
to stop the simulation is available.

2. After the simulation, the output quantities are displayed in the plots on the sheet or in the
report windows. Output data are also saved in an .sdb file (Simplorer Database).

Plotting Rectifier Model Simulation Results

In this section, you will create reports that graph the following outputs:

l Voltages of the sources ET1.V, ET2.V, and ET3.V
l Voltage of the smoothing capacitor CD.V
l Current of the load resistor R_LOAD.I

The resulting plots should resemble those shown below.
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Begin by creating a 2D rectangular report that plots the three-phase voltage source outputs.

1. Right-click onResults in the Project tree and selectCreate Standard Report>Rect-
angular Plot from the context menu.

A new Reportwindow appears.
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2. Under Category, selectVoltage. While pressing theCtrl key, select ET1.V, ET2.V, and
ET3.V in theQuantity list. Keep all other settings unchanged.
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3. Click theNew Report button to create a report similar to the following:

A Result namedXY Plot 1 appears in theProject Manager tree.

4. Without closing theNew Report dialog, select CD.V in the Quantity list.
5. ClickNew Report to create a report showing the smoothing capacitor voltage similar to the
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following:

A Result namedXY Plot 2 appears in theProject Manager tree.

6. Without closing theNew Report dialog, select Current in the Category list; then select R_
LOAD.I in the Quantity list.

7. ClickNew Report to create a report showing the load resistor current similar to the fol-
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lowing:

A Result namedXY Plot 3 appears in theProject Manager tree.

8. ClickClose to close theNew Report dialog box.

Simplorer allows you to customize reports such as the one you created in this example in many
ways. For example, you can rename plots by right-clicking on a plot name in theProject Manager
tree, and selectingRename from the context menu. You can also adjust the background color; grid
scale and color; text font, size, and color; trace color, line style, and thickness; legend text; add vari-
ous datamarkers, etc.

You can also use the tools in Simplorer’sDrawmenu to add your own custom elements and text to
your reports. Detailed information onGenerating andModifying Reports is available in the online
help.
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4 - Hysteresis Current-Controlled DC-Motor
Start-Up

In this chapter, the example from chapter 3 ismodified as follows:

l The resistive/inductive load is replaced with a real machinemodel (DC motor with per-
manent excitation).

l The example is then expanded to create a simple, current-controlledmachinemodel by
adding a two-point hysteresis element, a chopper transistor, and a freewheeling diode.
The other parts of the circuit — the three-phase power supply with rectifier bridge— remain
unchanged.

l In the second example, the controller ismodeled with state graph components.

Modify the Rectifier Model Design
The figure below shows a Schematic sheet of the simulationmodel you will design in this section.
Themodel consists of a three phase power supply, a rectifier bridge with static diodes and their
characteristics, a smoothing capacitor, a DC machinemodel, Chopper transistor, and freewheeling
diode.

Simplorer Getting Started Guide
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Deleting the Resistive/Inductive Load

First, you need to delete the components which are not used in themodified simulationmodel. In
place of the resistive/inductive load, you will add a DC machinemodel, a freewheeling diode, and a
chopper transistor.

1. Select and delete resistorR_LOAD and inductor L_LOAD.

You can select them one at a time (selected elements turn red); or drag themouse around
them to select both elements.

To delete the selected components you can:

l ChooseEdit>Delete.
l Right-click and chooseDelete from the short-cut menu.
l PressCTRL+X.

2. Select and delete the remains of the interconnecting wires.

Saving the Sheet with a New Name
1. Choose File>Save As.
2. Enter a new file name.
3. ClickOK.

Placing and Arranging the New Block Components on the Sheet

First, place and arrange the new components needed for the PI Controller in the extended sim-
ulationmodel. TheComponent Libraries provides access to the library containing the Simplorer
basic components, which are used for this example.
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Module Group Component Quantity
Blocks Continuous Blocks GAIN: Gain

INTG: Integrator

2

1

Sources Blocks CONST: Constant Value 1

Signal Processing Blocks LIMIT: Limiter

SUM: Summation

1

3

Tools Time Functions DATAPAIRS: 2D Look-up Table 1

1. Open the SimplorerBasic Elementsmodel library folder by clicking the + symbol next to the
folder. You can also double-click theBasic Elements folder icon or name to open it.

2. Place the component onto the sheet. Select the folder Blocks and then the folder
Continuous Blocks. Select the componentGain and drag the component onto the sheet.

3. Arrange the component on the sheet. To connect the components, youmust place
them in appropriate positions. See the simulationmodel figure on "Current and Speed Con-
trolled DC Motor" on page 5-1. Orient each component as needed so that it can be easily con-
nected with the other components.

4. Repeat steps 2 and 3 until all new components used in this example are placed on the sheet.

Connecting the New Components

When all the components are arranged, you can connect them as required for this example.

Connect the components as required for the controller.Using the simulationmodel shown
on "Current and Speed Controlled DC Motor" on page 5-1 as a guide, place the cursor on the ele-
ment pins and set the beginning, the corners, and the end of a wire with themouse. PressEsc to
exit the wiremode.

Note Connections to themotor’sLOAD (load torque), IA (armature current), andN (rotor
speed) parameters are not visible on the schematic. These connectionswill be added later.

Defining DC Machine Values
1. Define component properties. Double-click the DCMPmachine symbol to open itsPara-

meters dialog box.
2. On theParameters tab, change theName fromDCMP… toDCM., and define the following

machine parameters:
l RA: Armature Resistance:1.2 ohm
l LA: Armature Inductance:9.5mH
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l KE: Back EMF Constant: 0.544Wb
l J: Rotor Moment of Inertia:0.004 kgm2

3. In theDefault Outputs section of theParameters tab, checkN and IA to enable them as
outputs. You will use these later when creating reports.

4. Make the names of themechanical load and armature current properties visible on the
sheet. (These two properties will be used later.)
a. Click the Output/Display tab. In theName column, select LOAD (Load Torque). Under

Visibility, selectName. Leave Location as-is.
b. Similarly set visibility and location for IA (Armature Current).
c. ClickOK to apply the changes.

5. Move the property names to appropriate positions.

You can rotate property names displayed on the sheet by clicking the name to highlight it,
then pressingCtrl+R repeatedly until the name is oriented as desired. Activate themove
mode bymoving themouse pointer over the name you want to move until themouse-pointer
changes into a pointer with a four-headed arrow. Click and drag the name to the new pos-
ition.

Defining Mechanical Load

Themechanical load of themachinemodel can be set in many different ways. The variant used in
this example is based on an initial value (ICA) component. This component is useful when initial val-
ues are used for different models on the sheet. In this example, the equation defined within the ICA
component is used to “connect” an initial value, 0, to the load torque parameter of themachine com-
ponent. Values in the ICA component are set only once at the simulation start.

1. Define a new entry within the initial value list.
a. Double-click the ICA symbol to open itsParameters dialog box.
b. On theState tab, change theName to FML_INIT and checkShow Name.
c. Create a new Equation entry with theAdd (yellow lightning-bolt) button.
d. Click in theEquation field and type LOAD:=0. This creates a new ICA parameter

named LOAD and assigns it a value of 0 (zero).
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e. To display the LOAD parameter name and value, check the LOAD parameter’sShow
check box.

f. ClickOK to apply the changes. The new parameter is now defined and is available for
connecting with a quantity.

2. Connect the ICA initial value to the LOAD property of the DC machine.
a. Double-click the DC machine symbol to open itsParameters dialog box.
b. On the Parameters tab, type LOAD in the Value cell for the LOAD property, and click

OK. This “connects” the DC machine LOAD property to the LOAD value specified in the
ICA component.

Freewheeling Diode
Define the parameters of the diode.

1. Double-click the diode symbol to open itsParameters dialog box and set parameters.
2. Change theName fromDn toD7.
3. Select Type and chooseExponential Function from the list.
4. Leave all other values as they are. ClickOK to apply the changes.

Chopper Transistor
The transistor turns on and off depending on themachine current, IA. Initially, the transistor is set
“on” to start the process.

Define the parameters of the transistor.
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1. Double-click the transistor symbol to open itsParameters dialog box.
2. Change theName fromBJTn to TR1.
3. Select Type and chooseExponential Function from the list.
4. Leave all other values as they are. ClickOK to apply the changes.
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Controller Modeling Using Block Elements

Initially, the current-controller is designed using a two-point element with hysteresis. The block ele-
ment input signal is the DC machine current, IA. The output signal controls the chopper transistor,
TR1.

1. Define component properties of the Two-point element.Double-click the symbol to
open itsParameters dialog box. On theParameters tab, change theName from TPHn to
CONTR_OUT, then define the following parameters:
l THRES1 (Threshold T1): 17.5
l THRES2 (Threshold T2):22.5
l VAL1 (Value A1):1
l VAL2 (Value A2):0
l Y0 (Initial Value):1

2. Define the Block sample time, TS. The smaller the block sample time, themore precise
the current control of themachine. In this example, the system sample time is used, i.e., the
block is calculated using the same sample time that the circuit models use. To ensure that
the system sample time is used, set the TS (Sample Time) parameter to 0 (zero).

3. “Connect” the IA parameter of the DC machine (DCM) to the input of the hys-
teresis block.
a. First, on theOutput/Display tab, uncheckShow Pin for the INPUT parameter. For Vis-

ibility, selectBoth to display the parameter and its value.
b. Next, on theParameters tab, typeDCM.IA in the INPUT parameter Value field.
c. ClickOK to apply the changes. Position the text as needed.

4. Connect the output pin of the block with the input pin of the control signal of the
bipolar junction transistor. The cursor changes to crosswires. Connect both pins by click-
ing them. PressESC to finish the wiremode.

All parameters of themodified simulationmodel should now have the correct values. The table
below lists all new components of the simulationmodel and their parameter values.

Name Type Parameters
DCM RA (Armature Resistance)=1.2 ohm

LA (Armature Inductance)=9.5 mH

KE (Back EMF Constant)=0.544 Wb

J (Rotor Moment of Inertia)=0.004 kgm2
FML_INIT1 LOAD:=0

D7 Exponential Function ISAT (Saturation Current)=1e-012 A

VT (Thermal Voltage)=0.035 V
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Name Type Parameters
RR (Reverse Resistance)=100k ohm

TR1 Exponential Function ISAT (Saturation Current)=1e-012 A

VT (Thermal Voltage)=0.035 V

RR (Reverse Resistance)=100k ohm

CTRL (Control Signal)=CONTR_OUT.VAL (pin)
CONTR_OUT THRES1 (Threshold T1)=17.5

THRES2 (Threshold T2)= 22.5

VAL1 (Value A1)=1

VAL2 (Value A2)=0

Y0 (Initial Value)=1

TS (Sample Time)=0 (System time)

INPUT (Input Signal)=DCM.IA
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Modifying Report Elements

1. Define the model output DCM.N.
a. In the Project Manager window, under Results on the Project tab, double-click theXY

Plot 1 report icon to open the report window.
b. Ctrl+click each of the traces to select them all, then pressDelete to remove the traces.

You can also right-click and selectEdit>Delete from the context menu.
c. Right-click theXY Plot 1 report icon and selectModify Report to open the report dialog

box.
d. In theCategory list, clickAll, then selectDCM.N in theQuantity list.
e. Click theAdd Trace button to display the output.
f. ClickClose to close the dialog box.
g. In theProject Manager window, right-clickXY Plot 1 and selectRename from the con-

text menu. Change the title of the plot toSpeed. PressEnter to apply the change.
2. Define the model output DCM.IA.

a. Double-click theXY Plot 2 symbol to open the report window.
b. Select theCD.V trace and use theDelete button to delete it.
c. Create a new output forDCM.IA.
d. Change the title of the plot toCurrent. See also Plotting Rectifier Model Simulation Res-

ults.

Display Diode Characteristic
Plots can also be used to display component characteristics. For such cases, the X-axis is defined
in some quantity other than simulation time.

1. Define the axes quantities.
a. In the Project Manager window, under Results on the Project tab, double-click theXY

Plot 3 symbol to open the report dialog box.
b. Select theR_LOAD.I trace andDelete it.
c. Create a new Y-axis output forD1.I. Remember to useSimplorer Circuit>Output Dia-

log to define output quantities as needed.
d. Select a new X-axis quantity by uncheckingDefault. Then click [...] and selectD1.V on

the Select X Component dialog box.
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e. ClickOK to close the Select X Component dialog box.
f. In the report dialog box, clickApply Trace to apply the changes; then clickClose to

close the dialog box.
g. By default, the trace type is a continuous (solid) line. To edit the trace properties so that

you can see the individual simulation points on the curve, click the trace to select it (The
cursor changes color when hovering over a selectable display element). In the dock-able
Properties window, change the Trace Type toDiscrete.

To view the area of interest on the characteristic curve, you need tomanually edit the X- and Y-axis
properties.

a. Double-click the X-axis to select it and open itsProperties dialog box.
b. On theScaling tab, uncheckAuto Units and selectV as theUnits value. CheckSpe-

cify Min, then enter 0.55 in theMin Value field. Similarly, checkSpecify Max and enter
0.9 for theMax value. Next checkSpecify Spacing and enter 0.05 in theSpacing field
to set the interval betweenmajor tickmarks on the X-axis. Leave the rest of the settings
as they are and clickOK to apply the changes and close the dialog box.

c. Double-click the Y-axis to select it and open itsProperties dialog box.
d. On theScaling tab, uncheckAuto Units and selectA as theUnits value. CheckSpe-

cify Min and enter 0 in theMin Value field. CheckSpecify Max and enter 0.1 for the
Max value. CheckSpecify Spacing and enter 0.025 in theSpacing field to set the inter-
val betweenmajor tickmarks on the Y-axis. Leave the rest of the settings as they are and
clickOK to apply the changes and close the dialog box.

e. Change the title of the plot toCharacteristic.
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Defining Simulation Parameters
Simulation parameters control the simulation process. The values chosen for a simulation determ-
ine the success, and affect the quality, of a simulation result.

1. ChooseSimplorer Circuit>Add Solution Setup>Transient to define the simulation para-
meters.

2. Change the default values for simulationEnd Time from 40ms to 0.5ms, forMin Time Step
from 10us to 1ns, and forMax Time Step from 1ms to 1us. ClickOK to apply the changes.

Starting Simulation (Block Components)
Start the simulation with theSimplorer Circuit>Analyzemenu command or right-click on the
Analysis icon in theProject Manager window and selectAnalyze from the short-cut menu. The
simulationmodel is compiled and calculated.

Simulation Results (Block Components)

The Speed and Current plots display the simulation results for themachine armature current
(DCM.IA) and speed (DCM.N). Depending on the armature current, the two-point element with
hysteresis controls the switching behavior of the chopper transistor. The speed for the DC motor
no-load starting torque approaches 2613 rpm.

The Characteristic plot displays diode D1’s current as a function of its voltage and should look sim-
ilar to the image below.
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Controller Modeling Using State Graph Components
Simplorer’s state graphmodule, which is based on thePetri Net theory, allows you tomodel event-
driven, discontinuous processes. The theoretical basis of themodeling divides a system into sig-
nificant states and events, and transitions from one state to the other. The following procedure
explains themodeling of the two-point hysteresis controller with state graph components.

First, place and arrange the state graph components used in themodified simulationmodel. Any
unused area of the sheet may be used.

1. Choose the Simplorer model library Basic Elements.
2. Place the component onto the sheet. Select the folder States.Select the componentState

11and drag it onto the sheet.
3. Arrange the component on the sheet. Orient the component so that it can be connected with

the other components in themanner show in figure below.
4. Repeat steps 2 and 3 until all new components used in the state graph are placed on the

sheet

Module Group Component
States State 11 2x

Transition 2x

Tools Equations Initial Values 1x
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5. All of the required components for the state graph are now on the sheet. To connect the com-
ponents, youmust place them in appropriate positions as shown in the figure below. Note in
particular the directions of the arrows on the Transition components and rotate or flip com-
ponents as needed.

Connecting the State Graph Components

When all of the state graph components are arranged, you can connect them as required for this
example. Make certain to consider the direction of the transition components.

1. Activate the wire mode.ChooseDraw>Wire or use theCtrl+W keyboard shortcut. The
cursor changes to crosswires.

2. Connect the components as required for the circuit.Place the cursor on the element
pins and set the beginning, the corners, and the end of a wire with themouse. PressEsc to
finish and exit the wiremode.

Defining the Properties of State Graph Components

A process sequence can be considered as a sequence of states. The current state is called active.
Switching the activity from a given state to its successor state is called an event. An event occurs
only if: all previous states are active, all following states are inactive, and the transfer condition— in
the form of a logical expression— is true. At the beginning of the simulation, one statemust be
defined as active.

1. Define the parameters of the state ON.
a. Double-click theSTATE11 symbol on the left to open its Parameters dialog box.
b. Change theName fromSTATE… toON.
c. Create a new SETAction Type entry with theAdd button.
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d. TypeCS in theName field and 1 in theValue field. This entrymeans that the variable
CS (control signal) is set to 1 if the state is active. You can click the [...] button to open the
Calculator window and confirm the expressionCS:=1 is present. (ClickOK orCancel
to close the window.)

e. Check theActivate State box to set the state active at the beginning of the simulation.
f. Ensure that the TR radio button is selected.
g. ClickOK to apply the changes.

The blue circle in the symbol indicates the state is active. During a simulation, the statemark-
ers “run” through the state graph, depending on the active states in the simulation process.

2. Define the parameters of the OFF state.
a. Double-click the state symbol on the right to open the property dialog and set para-

meters.
b. Change theName fromSTATE… toOFF.
c. Create a new SETAction Type entry with theAdd button.
d. TypeCS in theName field and 0 in theValue field. This entrymeans that the variable

CS (control signal) is set to 0 if the state is active.
e. ClickOK to apply the changes.

3. Define the parameters of the initial value component.
a. Double-click the ICA symbol to open the component dialog box and set parameters.
b. Turn off the Name and then create four new entries with theAdd button.
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c. Click in theEquation field and type the name:=value corresponding to the picture.

You can also enter a description of each equation in the Information field and display the descrip-
tions on the schematic by enablingShow.

d. ClickOK to apply the changes.
4. Define the parameters of the first transition.

a. Double-click the top Transition symbol to open the parameter dialog box.
b. TypeDCM.IA>=IUPR in theCondition for transition field. This entrymeans that the

condition becomes true if themachine armature current (DCM.IA) is greater-than or
equal-to the variable IUPR. The variable IUPR is defined in the initial value component.

c. Clear Show Name.
d. CheckShow Condition to display the condition on the schematic.
e. ClickOK to apply the changes.

5. Define the parameters of the second transition.
a. Double-click the lower Transition symbol to open the parameter dialog box to define the

transfer condition.
b. TypeDCM.IA<=ILWR in theCondition for transition field. This entrymeans that the

condition becomes true if themachine armature current is less-than or equal-to the vari-
able ILWR. This variable is also defined in the initial value component.

c. Turn off the name, and checkShow Condition to display the parameter value.
d. ClickOK to apply the changes.

Note Using the “=” operator type forces the simulator to synchronize on the condition
with theminimum time step. Because of this, the state graph worksmore pre-
cisely than the two-point hysteresis component, but the processing time of the
simulation is longer.
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Using Name References

To control the switching behavior of the transistor, TR1, you need to enter the control variableCS
in the transistor dialog.

1. Double-click the transistor symbol to open the Parameters dialog to define the control para-
meter.

2. Clear theControl SignalUse Pin box, and enter the control variableCS in theControl Sig-
nal field.

3. ClickOK to apply the changes.

Deactivating Components on the Sheet

You can deactivate separate components or parts of amodel sheet for a simulation run. The com-
ponents and all of their properties remain on the sheet, but the simulator ignores the deactivated
components. The connection between the terminals is considered open. This feature is especially
helpful when you want to test simulationmodels with several different elements and parameters.
Components can be deactivated with theEdit>Deactivate (Open)menu command or the same
command in the shortcut menu for the selected element. A deactivated (Open) component will
have a large redX over it.

Select the hysteresis blockCONTR_OUT and chooseEdit>Deactivate (Open). The wires, con-
nected with themachinemodel and transistor, remain on the sheet.
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All parameters in themodified simulationmodel now have the correct values. The table below lists
all new components of the simulationmodel and their parameter values.

Name Type Parameters
TR1 Exponential Function Saturation Current [A]=1e-12

Thermal Voltage[V]=0.035

Reverse Resistance[Ω]=100k

Control Signal=CS
CONTR_OUT Deactivated Threshold T1=17.5

Threshold T2= 22.5

Value A1=1

Value A2=0

Initial Value=1

Sample Time=0 (System)

Input=DCM.IA
TRANS1 DCM.IA>=IUPR
TRANS2 DCM.IA<=ILWR
ON SET:CS:=1
OFF SET:CS:=0
FML_INIT2 IREF:=20
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Name Type Parameters
DELTA:=2.5

IUPR:=IREF+DELTA

ILWR:=IREF-DELTA

Starting Simulation (State Graph)

Start the simulation with theSimplorer Circuit>Analyzemenu command or the right click on the
Analysis icon on the Project window and selectAnalyze from the short-cut men. The simulation
model is compiled and calculated.

Simulation Results (State Graph)

TheSpeed andCurrent plots display the simulation results for themachine armature current
(DCM.IA) and speed (DCM.N). Depending on the armature current,DCM.IA, the state graph con-
trols the switching behavior of the chopper transistor. The speed for the DC motor no-load starting
condition approaches 2550 rpm.

The tolerance band of the state graph controller ismore precise than for the hysteresis controller,
because the “=” operator type in the state graph forces the simulator to synchronize on the con-
dition with theminimum time step. To force any of the blockmodels to calculatemore precisely, you
can define a special sample time in themodel’s property dialog.
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5 - Current and Speed Controlled DC Motor
In this chapter the example fromChapters 3 and 4 is extended further:

l The state graph/hysteresis controller is replaced with a PI (proportional-integral) controller
implemented using block components.
The other parts of the circuit, such as the three-phase power supply with rectifier bridge,
remain unchanged.

In addition to basic functions (selecting, placing, arranging, and connecting components), this
chapter introduces the following Simplorer features:

l Modeling with block components
l Examining Block Sequence
l Using Pins for parameter transfer
l Using Characteristic components

Modify the State Graph Design
The figure below shows the Schematic sheet of the simulationmodel with the corresponding val-
ues of components: three phase power supply, the rectifier bridge, smoothing capacitor, motor,
and the PI controller.

Simplorer Getting Started Guide

Current and Speed Controlled DC Motor 5-1

Simplorer 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Simplorer Getting Started Guide

Deleting the State Graph

First, you need to delete the components that are not used in themodified simulationmodel.
Instead of the state graph or simple hysteresis controller, you will use a PI controller consisting of
block diagram components.

1. Select the components to delete. Hold down theCtrl key and select the state graph com-
ponents: FML_INIT1, and FML_INIT2, STATE_11 (both ON andOFF), and the two Trans-
ition components by clicking them to highlight the components.

2. Delete the components. ChooseEdit>Cut. The components are removed from the sheet.
You can also pressCtrl and theX key at the same time; or you can use theDelete key on
your keyboard.
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3. Delete the remaining wires. Select any remaining unused wires by holding down theCtrl
key and clicking to select them. PressCtrl+X to remove the wires.

Saving the Sheet with a New Name
1. Choose File>Save As.
2. Enter a new file name.
3. ClickOK.

Placing and Arranging the New Block Components on the Sheet

First, place and arrange the new components needed for the PI Controller in the extended sim-
ulationmodel. TheComponent Libraries provides access to the library containing the Simplorer
basic components, which are used for this example.

Module Group Component Quantity
Blocks Continuous Blocks GAIN: Gain

INTG: Integrator

2

1

Sources Blocks CONST: Constant Value 1

Signal Processing Blocks LIMIT: Limiter

SUM: Summation

1

3

Tools Time Functions DATAPAIRS: 2D Look-up Table 1

1. Open the SimplorerBasic Elementsmodel library folder by clicking the + symbol next to the
folder. You can also double-click theBasic Elements folder icon or name to open it.

2. Place the component onto the sheet. Select the folder Blocks and then the folder
Continuous Blocks. Select the componentGain and drag the component onto the sheet.

3. Arrange the component on the sheet. To connect the components, youmust place
them in appropriate positions. See the simulationmodel figure on "Current and Speed Con-
trolled DC Motor" on page 5-1. Orient each component as needed so that it can be easily con-
nected with the other components.

4. Repeat steps 2 and 3 until all new components used in this example are placed on the sheet.

Connecting the New Components

When all the components are arranged, you can connect them as required for this example.

Connect the components as required for the controller.Using the simulationmodel shown
on "Current and Speed Controlled DC Motor" on page 5-1 as a guide, place the cursor on the ele-
ment pins and set the beginning, the corners, and the end of a wire with themouse. PressEsc to
exit the wiremode.
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Note Connections to themotor’sLOAD (load torque), IA (armature current), andN (rotor
speed) parameters are not visible on the schematic. These connectionswill be added later.

Defining Mechanical Load (Block)

TheDATAPAIRS: 2D Look-up Table (already placed on the sheet) allows the definition of
wave-forms from a set of fixed data points either with linear interpolation between them (straight
lines from point-to-point), or rectangular lines between them (two orthogonal lines— parallel to the
coordinate axes— from point-to-point). The X-values of the data-pairsmust bemonotonously
increasing. The last slope is effective for all values outside the X range. If you want to have a con-
stant value outside the X-range, you need to define two data-pairs with the same Y-value at the
end. In this example, the 2D Lookup Table is used to define themechanical load of the DC
machine.

1. Define the load characteristic.
a. Double-click the 2D Look-up Table symbol to open theParameters dialog box and set

parameters.
b. Change theName to LOAD.
c. ChooseWithout from the Interpolation list.
d. ClickCharacteristic to open theCharacteristic dialog box.
e. Choose the Internal Reference radio button, then clickDatasets to open theDatasets

dialog box.
f. ClickAdd to open anAdd Dataset dialog box. Enter the values as shown in the figure

below.
g. A default unique name is assigned to each dataset. Change theName to something

more descriptive such as Load_Torque.
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h. ClickOK to save the dataset. TheAdd Dataset dialog box closes - returning you to the
mainDatasets dialog box.

i. ClickDone to close theDatasets dialog box. TheCharacteristic dialog box should now
show the name of the dataset you created in itsDataset field.

j. ClickOK to close this dialog box.
k. On the 2D Look-up TableParameters tab, checkValue in theOutputs section.
l. ClickOK to close the 2D Look-up TableParameters dialog box.

2. Connect the output parameter value of the LOAD characteristic with the load of
the DC machine.
a. Open the LOAD characteristicParameters dialog box.
b. On theOutput/Display tab, uncheckShow Pin for theVAL parameter, and clickOK to

close the dialog box.
c. On theParameters tab of the DC machineParameters dialog box, type LOAD.VAL in

theValue field for the LOAD parameter. This connects the LOAD element characteristic
output to themachine’s LOAD input parameter.

d. In theDefault Outputs section, ensure thatN and IA are checked to enable them to be
used later when creating reports.

e. ClickOK to close the dialog box.
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Defining the PI Controller
The components that have been placed and connected still have their default parameter values.
You will now assign proper values for the components that comprise the PI Controller. Use the sim-
ulationmodel figure "Current and Speed Controlled DC Motor" on page 5-1 as a guide.

1. Define the parameters of the first gain block.
a. Double-click theGain block symbol to open itsParameters dialog box.
b. On theParameters tab, change theName toN.
c. Type -16.6667 for theKP (Proportional Gain) parameter Value and selectm for its

Units.
d. Change the parameter Value toDCM.N*1. This “connects” the gain block input to the

DC machine’s rotor speed output parameter with a scaling factor of 1. On theOut-
put/Display tab, uncheckShow Pin for the INPUT parameter.

e. ClickOK to close the dialog box.
2. Define the parameters of the constant value block.

a. Double-click theCONST block symbol to open itsParameters dialog box.
b. Change theName toN_REF and theValue to 16.6667. Ensure thatUse System

Sample Time is checked and thatBlock Output Signal is unchecked.
c. ClickOK to apply the changes.

3. Define the parameters of the summation of the N gain block and the N_REF constant block.
a. Double-click the summation symbol to the right of theN gain block to open itsPara-

meters dialog box.
b. Ensure thatUse System Sample Time is checked and thatBlock Output Signal is

not checked.
c. ClickOK to apply the changes.

4. Define the parameters of the second gain block.
a. Double-click theGAIN block symbol to open itsParameters dialog box.
b. Change theName toP_GAIN and the Proportional Gain (KP) to 50.
c. ClickOK to apply the changes.

5. Define the parameters of the integrator block.
a. Double-click the I block symbol to open itsParameters dialog box.
b. Change theName to I_GAIN and the Integral Gain (KI) to 20. The specification of “0” for

upper limit (UL) and lower limit (LL) means that there is no limitation.
c. ClickOK to apply the changes.

6. Define the parameters of the summation of P_GAIN and I_GAIN.
a. Double-click the summation symbol to the right of theP_GAIN block to open itsPara-

meters dialog box.
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b. Ensure thatUse System Sample Time is checked and thatBlock Output Signal is
not checked.

c. ClickOK to apply the changes.
7. Define the parameters of thelimiter block.

a. Double-click the limiter symbol to open itsParameters dialog box.
b. Change theName to LIMITER and the Upper Limit of Output Signal (UL) to 20.
c. ClickOK to apply the changes.

8. Define the parameters of thesummation of machine current and limiter value.
a. Double-click the summation symbol to the right of the LIMITER block to open itsPara-

meters dialog box.
b. For INPUT[1], un-checkUse Pin.
c. EnterDCM.IA in the Input Signal field to link the DC machine armature current to

INPUT[1].
d. Click in theSign column and select “–” from the list. The sign is applied to theDCM.IA

input signal.
e. Ensure thatUse System Sample Time is checked and thatBlock Output Signal is

not checked.
f. ClickOK to apply the changes.

9. Modify the parameters of thehysteresis block.
a. Right-click the hysteresis block symbol and choose Activate on the context menu.
b. Double-click the hysteresis block symbol to open itsParameters dialog box.
c. Define the parameters as follows:

l THRES1 (Threshold T1):-2.5
l THRES2 (Threshold T2):2.5
l VAL1 (Value A1):0
l VAL2 (Value A2): 1
l Y0 (Initial Value):1
l TS (Sample Time):5with unitsus
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d. ClickOK to apply the changes.
10. Modify the parameters of transistor TR1.

a. Right-click the TR1 symbol to open itsParameters dialog box.
b. On theParameters tab, clear theControl Signal field, then checkUse Pin to recon-

nect the transistor's control pin to the output of the hysteresis block.
c. ClickOK to close the dialog box.

All parameters of the PI controller should now have the correct values. The table below lists all com-
ponents of the PI controller and their parameter values.

Name Output To Parameters
N SUM1 KP (Proportional Gain)=-16.6667m

TS (Sample Time)=System (0)

INPUT (Input Signal)=DCM.N
N_REF SUM1 Value=16.6667

Sample Time=System

SUM1 P_GAIN

I_GAIN

Sample Time=System

Input[0]=N.VAL

INPUT[1]=N_REF.VAL
P_GAIN SUM2 KP (Proportional Gain)=50

TS (Sample Time)=System (0)

INPUT (Input Signal)=SUM1.VAL
I_GAIN SUM2 KI (Integral Gain)=20

Y0 (Initial Value)=0

UL (Upper Limit)=0

LL (Lower Limit)=0

TS (Sample Time)=System (0)

INPUT (Input Signal)=SUM1.VAL
SUM2 LIMITER Sample Time=System

Input[0]=P_GAIN.VAL

INPUT[1]=I_GAIN.VAL
LIMITER SUM3 UL (Upper Limit)=20

LL (Lower Limit)=0
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Name Output To Parameters
TS (Sample Time)=System (0)

INPUT (Input Signal)=SUM2.VAL
SUM3 CONTR_OUT Sample Time=System

Input[0]=LIMITER.VAL

INPUT[1]=-DCM.IA
CONTR_OUT TR1.CTRL THRES1 (Threshold T1)=-2.5

THRES2 (Threshold T2)= 2.5

VAL1 (Value A1)=0

VAL2 (Value A2)=1

Y0 (Initial Value)=1

TS (Sample Time)=5us

INPUT (Input Signal)=SUM3.VAL
LOAD DCM.LOAD Interpolation=Without

TPERIO (Period)= 0.1

PHASE (Phase)= 0

PERIO (Periodical)= Yes

TDELAY (Initial Delay)= 0

CHARACTERISTIC DATASET= $Load_Torque
x=0 y=0
x=0.075 y=10
x=0.1 y=10

Starting Simulation

Start the simulation with theSimplorer Circuit>Analyzemenu command or the right click on the
Analysis icon on theProject Manager window and selectAnalyze from the short-cut men. The
simulationmodel is compiled and calculated.

Adding a Rectangular Plot (PI Controller)
1. Add a Rectangular Plot.

a. In the Project Manager tree, right-click the Results icon and selectCreate Standard
Report>Rectangular Plot.
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b. A Report dialog box opens.
2. Define the model outputs DCM.IA, DCM.N, LOAD.VAL.

a. UnderCategory, selectAll.
b. In the Quantity list, selectDCM.N and clickNew Report to create the report.
c. Without closing theNew Report dialog, selectDCM.IA in theQuantity list.DCM.IA

appears in theY trace field. Its blue color signifies that it is a valid expression.
d. Simplorer allows you to apply various functions such as a scale factor to the selected

quantity. Place the cursor at the beginning ofDCM.IA in theY field and type 10* to mul-
tiplyDCM.IA by a factor of ten. As you are entering the factor, the color of the expression
may change to red at times indicating that the expression as shown at that point is
invalid. The finished expression should be: 10*DCM.IA and be blue indicating that it is
valid.

e. ClickAdd Trace to add the new scaled trace to the report.
f. Next select LOAD.VAL and apply a scale factor of 0.1k to it. The finished Y expression

should be 0.1k*LOAD.VAL.
g. ClickAdd Trace to add the trace to the report.
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h. ClickClose to close the report dialog box. The plot should look similar to the following:

Adjusting Plot Properties

Many of a plot’s properties can be adjusted. In the following procedure you will make changes to
various properties of the X- and Y- axes.

1. Change the Y-axis Properties.
a. Position the cursor over any part of the Y-axis labeled 0.1k*LOAD.VAL on the plot. The

arrow will turn green when hovering over a selectable area of the axis. Click the axis to
select it for editing. The axis scale will become bold when selected. The axis name and
scale numbers will also be underlined.

b. In the Properties window, select the Scaling tab.
c. Check theSpecify Min check box and type -0.5k in theMin Value field below it.
d. Check theSpecify Max check box and type 1.5k for theMax Value.
e. Check theSpecify Spacing box and change theSpacing value to 500. This setting con-

trols the interval betweenmajor “tick” divisions on the axis scale.
f. ChangeMinor Tick Divs to 1. This setting controls the number of divisions between

major divisions.
g. Repeat steps a through f for the Y- axis labeledDCM.N.

Current and Speed Controlled DC Motor 5-11

Simplorer 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Simplorer Getting Started Guide

h. For 10*DCM.IA Y-axis, first clear theAuto Units check box and setUnits toA, then
repeat steps a through f.

2. Change the X-axis Properties.
a. Select the X-axis for editing.
b. On the Scaling tab, uncheckAuto Units and select aUnits setting of s (seconds).
c. SetMin value to 0,Max value to 0.1, Spacing to 0.01, andMinor Tick Divs to 1.

The finished plot should look similar to the following:

Refer to the online help for additional information on adjusting plot properties.

Checking the Block Sequence
The sequence of block computation can significantly influence the simulation result. You can
change the block sequence with theSchematic>Sort Componentsmenu command.
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Using Automatic Block Sorting
WhenBlock Sequence sorting is determinedAutomatically, the blocks are sorted according to
their signal direction after simulation begins. Automatic block sequence sorting is the default mode
used for simulation.

Using Manual Block Sorting
To sort blocksmanually, you can select block items in theDetermine Block Sequence dialog box
list and use the up and down arrow buttons to change the sort order.

You can also click the Interactive button which closes the dialog box and displays the current
sequence in digits next to the blocks. You can then change the sequence by clicking the blocks in
the desired sequence on the sheet or by arranging the block list in a new sequence in the dialog.
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Rerun the Simulation (PI Controller)
After changing the Block Sequence, rerun the simulation with theSimplorer Circuit>Analyze
menu command. The simulationmodel is recompiled and recalculated.

Simulation Results (PI Controller)
The plot displays the simulation results for themachine armature current (DCM.IA), speed
(DCM.N), and the LOAD. Depending on the armature current, the PI controller adjusts the switch-
ing behavior of the chopper transistor. The no-load starting speed for the DC motor approaches
1000 rpm.
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6 - Using VHDL-AMS Components for
Modeling

This example describes themodeling of a PI controlled DC motor system using a VHDL-AMS com-
ponent for the DC machine Simplorer functions you will use in this example:

l Basic functions (selecting, placing, arranging, and connecting components)
l Modeling with VHDL-AMS components
l Using plots for displaying simulation results

VHDL-AMS Components
TheBasic Elements VHDLAMS library provides the user with themost common basic func-
tionality, circuit components and block elements as VHDL-AMSmodels developed according to
IEEE 1076.1 (VHDL Analog andMixed Signal Extensions Standard).

The functionality of the VHDL-AMSmodels is a subset of that available in the equivalent Simplorer
SML (Simplorer Modeling Language) models provided in theBasic Elements library. VHDL-AMS
models can be used in parallel with SMLmodels. VHDL-AMS block and circuit models are sim-
ulated by the analog solver; while SML block elements are solved by a separate block diagram sim-
ulator. Consequently, unlike SMLmodels. VHDL-AMSmodels will not display step delays along
the simulator backplane. Numerical values of the VHDL-AMS data type generic are defined at t = 0
and remain unchanged for the remainder of the simulation.

You can view the inputs and outputs of a VHDL-AMSmodel using the appropriate analog or digital
report. You can also view internal values used within the architecture of amodel on reports and use
them as variables betweenmodels. However, if the VHDL-AMS design needs to be exported to
other simulators then internal values of themodel should not be used outside themodel.

Modify the PI Controller Design
The figure below shows the Schematic sheet of the simulationmodel and corresponding values of
the three-phase power supply, the rectifier bridge with static diodes and their characteristics, the
smoothing capacitor, and the VHDL-AMSmachine component,DCM.
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Save the Project with a New Name
1. Choose File>Save As.
2. Enter a new file name, and clickOK.
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Delete the DC Machine Component
Delete the DC machine component that will be replaced with a VHDL-AMSmachine component.

1. Select the DC machine component by clicking it.
2. Press theDelete key to delete the component.

Placing and Arranging the New VHDL-AMS Components
on the Sheet

1. In theComponent Libraries window, select the componentAM: Ammeter from the Favor-
ites folder and drag it onto the sheet.

2. Open theBasic Elements VHDLAMS>Circuit>Electrical Machines folder. Select the com-
ponent dcmp: DC Permanent Magnet Excitation and drag it onto the sheet.

3. Arrange the components in appropriate positions. See the simulationmodel figure in"Modify
the PI Controller Design" on page 6-1.

Connecting the New VHDL-AMS Components
1. Connect the VHDL-AMS DC machine and ammeter component pins as indicated on

"Modify the PI Controller Design" on page 6-1.

Some pins are not available yet. Leave these connections out in this step. The connections are cre-
ated later.

Defining VHDL-AMS DC Machine Values
1. Open the VHDL-AMS DC machineProperties dialog box.
2. On theParameter Values tab, change InstanceName toDCM, la (Armature Inductance)

to 9.5 mH, ke (Back EMF Constant) to 0.544 Wb, and j (Moment of Inertia) to 0.004 kgm2.
3. On theQuantities tab, change ra (Armature Resistance) to 1.2 ohm. For the load (Load

Torque) property, type LOAD.VAL in itsValue field to “connect” it to the LOAD char-
acteristic component.
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4. On theProperty Displays tab add the following property and visibility settings:

5. ClickOK to apply the changes.
6. Open theProperties dialog box ofGain blockN. Override the default INPUTValue by enter-

ingDCM.n to connect it to the VHDL-AMSmotor speed property.

Defining Connections for Machine Current
1. Make the ammeter Current parameter pin available for connecting with the SUM3 com-

ponent input pin.
a. Double-click the ammeter symbol to open itsParameters dialog box.
b. On theParameters tab, change itsName toAM1.
c. On theOutput/Display tab, checkShow Pin for the I (Current) property.
d. ClickOK to apply the changes.

2. Make theSUM3 summation input pin available for connecting with the ammeterCurrent
pin.
a. Double-click theSUM3 component to open itsParameters dialog box. If a message dia-

log displays informing you thatDCM.IA is not a defined variable, just clickOK to con-
tinue.

b. On theParameters tab, for INPUT[1], deleteDCM.IA in the Input Signal field and check
Use Pin.

c. Ensure thatUse System Sample Time is checked and thatBlock Output Signal is
unchecked.

d. On theOutput/Display tab, change theVisibility of the INPUT[1] entry toNone.
e. ClickOK to apply the changes.
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3. Connect the input pin of theSUM3with the current pin of the ammeter.

Defining Simulation Parameters
Simulation parameters control the simulation process. The values chosen for a simulation determ-
ine the success, and affect the quality, of a simulation result.

1. ChooseSimplorer Circuit>Add Solution Setup>Transient to define the simulation para-
meters.

2. Change the default values for simulationEnd Time from 40ms to 0.5ms, forMin Time Step
from 10us to 1ns, and forMax Time Step from 1ms to 1us. ClickOK to apply the changes.

Analyze and Display Simulation Results (VHDL-AMS)
1. SelectSimplorer Circuit>Output Dialog and checkDCM.n andAM1.I to add them to the

Defined Outputs. ClickOK to close theOutput dialog box
2. Start the simulation with theSimplorer Circuit>Analyzemenu command.
3. In theProject Manager tree, expand the existing XY Plot and note that theDCM.N and

10*DCM.IA icons show that these traces are no longer valid because the variable names to
which theywere linked have been removed.

4. Right-clickDCM.N, selectModify Report, and set theY trace toDCM.n.
5. Similarlymodify 10*DCM.IA to 10*AM1.I. ClickOK to apply the changes.
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6. Double-click the XY Plot icon to display the plot which should look similar to the one below.
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7 - Variants of PWM Modeling
A frequently used component in power electronic applications is a Pulse-WidthModulation con-
troller. This device works using a constant frequency, variable impulse width, and a pulse duty
factor.

Simplorer offers several ways to generate amodel of this kind of device. In addition to the imple-
mentation of the internal circuit structure, behavioral models are increasingly important because
they provide high simulation speed combined with sufficient accuracy.

The following example contains PWMcontrollers designed using several distinct Simplorer mod-
elingmethods. All methods are included in one sheet so that you can easily compare the dif-
ferences between them.

Simplorer functions you will use in this example:

l Basic functions (selecting, placing, arranging, and connecting components)
l Modeling with block components
l Using Display Elements for displaying simulation results
l Using equations
l Defining block Sequence

PWM Modeling Overview
The figure below shows the Schematic sheet of the PWMcontrollers with the corresponding values
of components. The sheet contains the followingmodeling variants:

l Equation
l Equation and Time Function
l State Graph
l BlockDiagram
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Create a New Project for the PWM Models

Create a new Project and Schematic sheet for the Pulse-WidthModulationmodels that you will be
designing. Refer to Creating a New Project for details.

Setting Initial Conditions
The initial values defined in this section are used by all modeling examples in this chapter. These
values are set only once at the start of simulation.

1. In the Simplorer model library Basic Elements > Tools > Equations in the Component
Libraries window, select the component Initial Values and drag it onto the sheet.

2. Double-click the ICA symbol to open the FML_INIT parameters dialog box. Create a new
entry using the Add button . Click in theEquation field and enter FREQU:=10k.

3. Repeat step 2 to define the remaining initial values:
l HI:=5
l LO:=0
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l DUTY:=0.8
4. ClickOK to apply the changes.

PWM Modeling Using Equations
This first example describes themodeling of a PWMcontroller with the use of equations only. You
can separate the description into the following steps:

l Triangle function
l Real value output
l Normalized value output

As you build thismodel, note that Time andPI are used in the expressions describing the sim-
ulationmodel.

l The Simplorer simulator uses intrinsic variables for internal computation. One of these
intrinsic variables is the simulation time: Time. You can use this read-only variable in expres-
sions.

l The simulator also provides some natural andmathematical constants which can be used in
mathematical expressionswithin component dialogs. One such constant isPI.

l In addition, some standardmathematical functions, such as cos, are used in the expres-
sions.Refer to the online help for information on Simplorer’s standard functions.

1. Choose the SimplorerBasic Elements>Tools>Equations library in the Component Librar-
ies window. Select the FML:Equation component and drag it onto the sheet.

2. Double-click theEQU symbol to open the FML dialog box. Create a new Equation entry
with the Add button. Click in theEquation field and enter:
TRIANG1:=1/PI*acos(cos(2*PI*FREQU*Time))

3. Repeat step 2 and enter the following equations:
l EPWM1:=HI*(TRIANG1<DUTY)+LO*(TRIANG1>DUTY)
l EPWM1_NORM:=TRIANG1<DUTY

4. Ensure that theCalculation Sequence for all equations remains at the defaultBefore Ana-
log Solver setting. ClickOK to apply the changes.

Defining Simulation Parameters

Simulation parameters control the simulation process. The values chosen for a simulation determ-
ine the success, and affect the quality, of a simulation result.

1. ChooseSimplorer Circuit>Add Solution Setup>Transient to define the simulation para-
meters.

2. Change the default values for simulationEnd Time from 40ms to 0.5ms, forMin Time Step
from 10us to 1ns, and forMax Time Step from 1ms to 1us. ClickOK to apply the changes.
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Displaying Simulation Results with Reports

During a simulation several types of data are generated. These data can be displayed and printed
bymeans of Simplorer reports, or can be saved in files. Simplorer reports can be either stand-
alone, or can be placed directly on the sheet like components.

1. To add an on-sheet plot, chooseDraw>Report>Rectangular Plot. A hollow rectangular
box appears with the cursor at its center. Move the rectangle and click in the schematic win-
dow to place the plot center. The cursor moves to the lower right corner of the rectangle.
Drag the cursor to resize the rectangle as needed, then click again to finish placing the plot.

2. ChooseSimplorer Circuit>Output Dialog to open theOutput dialog box. Define outputs
for TRIANG1, EPWM1, andEPWM1_NORM by checking the output boxes of these quant-
ities. ClickOK to apply the changes.

3. Double-click the on-sheet report to open theReport dialog box. Ensure that theSolution is
TR, theDomain andPrimary Sweep are Time, and that theX channel is set toDefault via
the checkbox.

4. ClickAll in theCategory list. In theQuantity listCtrl+clickTRIANG1, EPWM1, and
EPWM1_NORM. ClickAdd Trace to add the traces to the plot, thenClose to exit the dialog
box.

5. Name the plot Equation Models by right-clicking its current name under Results in the Pro-
ject Manager and selectingRename. PressEnter to apply the change.

6. Save the project by choosing File>Save As and entering a name.
7. Start the simulation with theSimplorer Circuit>Analyzemenu command. The simulation

model is compiled and calculated.

Simulation Results

The plot displays the simulation results for the triangle function (TRIANG1), actual PWMsignal
(EPWM1) and normalized PWMsignal (PWM1_NORM). The value ofDUTY determines the pulse
width.
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PWM Modeling with Equations and Time Function
The second examplemodels a PWMcontroller using both equations and a time function. The
same initial value assignments set in the first example are also used in this example. It is unne-
cessary to connect the components directly because referenceswill be created using component
and parameter names.

1. In theBasic Elements>Tools>Time Functions library folder, select the TRIANG:Tri-
angular Wave component and drag it onto the sheet. Select the folder Equations and drag
an FML:Equation component onto the sheet.

2. Right-click the TRIANG symbol to open theParameters dialog box. On theParameters
tab, change theName to TRIANG2. Set the Amplitude (AMPL) to 0.5, Frequency (FREQ)
to FREQU, andOffset (OFF) to 0.5.

3. Select Value (VAL) and clear theShow Pin box. ClickOK to apply the changes.

Note You can leave the Value (VAL) output pin visible; however the pin is not used in this
example.
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4. Double-click the EQU symbol to open the FMLParameters dialog box. Create a new Equa-
tion entry with the Add button. In theEquation field enter:EPWM2:=HI*
(TRIANG2<DUTY)+LO*(TRIANG2>DUTY).

5. Repeat the above step to add the following equation:EPWM2_NORM:=TRIANG2<DUTY

ClickOK to apply the changes.

6. Add an on-sheet Rectangular Plot as in the first example. However, for this plot, define out-
puts and add traces for the TRIANG2.VAL, EPWM2, andEPWM2_NORM signals.

7. Name the plot Equation and Time Function Model; and save the project using File>Save
As.

8. Start the simulation with theSimplorer Circuit>Analyzemenu command. The simulation
model is compiled and calculated.

The resulting plot should be identical to the one plotted in the first example.

PWM Modeling with State Graph Components
This examplemodels the PWMcontroller using state graph components. The same initial value
assignments set in the first two examples are also used in this example. Simplorer’s state graph
simulator, which is based on the Petri Net theory, allows you tomodel event-driven, discontinuous
processes. Thismodelingmethod divides a system into significant states and events, then trans-
itions from one state to another.
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Place and Arrange the Components on the Sheet
1. In theBasic Elements library, open theStates folder and drag aState_11 component onto

the sheet. Change its name toOFF and rotate it to match the figure above. Drag a second
State_11 instance onto the sheet and label itON. Next, drag two TRANS components onto
the sheet and name them TRANS1 and TRANS2. Make sure to rotate them so that their
arrowsmatch the figure.

2. Drag a TRIANG component from theBasic Elements>Tools>Time Functions folder
onto the sheet. Change the component name to TRIANG3.

3. Connect the components as shown in the figure.

Define Component Properties

A process sequence can be considered as a sequence of states. The current state is called active.
Switching an activity from the current state to its successor state is called an event. An event occurs
only if:
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l All previous states are active.
l All following states are inactive.
l The transfer condition— in the form of a logical expression— is true.

At the beginning of the simulation, one statemust be defined as active.

1. Double-click theOFF state symbol to open itsParameters dialog box. Create a new SET
Action type entry with theAdd button. Enter EPWM3 in theName field and LO in theValue
field. This entrymeans that the variableEPWM3 is set to the value LO if the state is active.
Create another SET entry and enter EPWM3_NORM in theName field and 0 in theValue
field. Check theActivate State box to set the state active at the beginning of simulation.
ClickOK to apply the changes. A blue circle in the symbol indicates the state is active.

2. Similarly define the parameters of the stateON component in itsParameters dialog box.
Create a new SET entry and enter EPWM3 in theName field andHI in theValue field.
Create another SET entry and enter EPWM3_NORM in theName field and 1 in theValue
field. Do not checkActivate State. ClickOK to apply the changes.

3. Double-click the TRANS1 symbol and enter TRIANG3<DUTY in theCondition for trans-
ition field. This entrymeans that the condition becomes true if the value of the triangular func-
tion, TRIANG3, is lower than theDUTY value as defined in the initial value condition. Click
OK to apply the changes. Similarly, for TRANS2, enter TRIANG3>DUTY in theCondition
for transition field. In this case, the condition becomes true if the value of the triangular func-
tion is lower than theDUTY value. ClickOK to apply the changes.

4. Double-click the TRIANG3 symbol to open itsParameters dialog box. On theParameters
tab, set the Amplitude (AMPL) to 0.5, Frequency (FREQ) to FREQU, andOffset (OFF) to
0.5. On theOutput/Display tab uncheckShow Pin for Value (VAL) as the pin is not used in
thismodel. ClickOK to apply the changes.

5. Add an on-sheet Rectangular Plot as in the previous examples. However, for this plot, define
outputs and add traces for the TRIANG3.VAL, EPWM3, andEPWM3_NORM signals.
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6. Name the plot State Graph Model; and save the project using File>Save As.
7. Start the simulation with theSimplorer Circuit>Analyzemenu command.

The resulting plot should be identical to the one plotted in the first example.

PWM Modeling with Block Diagram Components

This examplemodels the PWMcontroller using block diagram components. The PWM is a com-
parator with two input signals: One input is the triangular wave and the other is themodulation sig-
nal. The comparator compares the signals and provides an output signal proportional to the
modulation signal.

Placing and Arranging the Components on the Sheet
1. In theBasic Elements>Blocks>Sources Blocks folder, select theCONST (Constant

Value) component and drag the component onto the sheet.
2. In theBasic Elements>Blocks>Signal Processing Blocks folder, locate and place one

SUM (Summation) and twoCOMP (Comparator) components onto the sheet.
3. In theBasic Elements>Tools>Time Functions folder, locate and drag a TRIANG (Tri-

angular Wave) component onto the sheet.
4. Arrange and connect the components as shown in the figure above.
5. Double-click the TRIANGsymbol to open itsParameters dialog box and change theName

to TRIANG4. On theParameters tab, set the Amplitude to 0.5, Frequency to FREQU, and
Offset to 0.5. ClickOK to apply the changes.
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6. Double-click theCONST block symbol to open theParameters dialog box. Change the
Name toDUTY_CYCLE andValue toDUTY. ClickOK to apply the changes.

7. Double-click theSUM symbol to open itsParameters dialog box. Click in theSign column
of the triangular wave Input SignalTRIANG4.VAL and select theminus sign (–) from the
list. ClickOK to apply the changes.

8. Double-click the uppermost comparator symbol to open itsParameters dialog box. Change
itsName toEPWM4. On theParameters tab, set Val1 to LO. and Val2 toHI. On theOut-
put/Display tab, clear theShow Pin box for the outputVAL. ClickOK to apply the changes.

9. For the remaining comparator, change its Name toEPWM4_NORM, Val1 to 0. and Val2 to
1. Clear theShow Pin box for the outputVAL. ClickOK to apply the changes.

10. Add an on-sheet Rectangular Plot as in the previous examples. However, for this plot, define
outputs and add traces for the TRIANG4.VAL, EPWM4.VAL, andEPWM4_NORM.VAL
signals.

11. Name the plotBlock Diagram Model; and save the project using File>Save As.
12. Start the simulation with theSimplorer Circuit>Analyzemenu command.

The resulting plot should be identical to the one plotted in the first three examples.
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8 - Using Legacy Schematics
To use a legacy Simplorer project, youmust first translate it using Simplorer Release 16.2 or earlier
and thenmigrate it into Simplorer R17.

In this chapter you will complete the following tasks:

l Translate a legacy Simplorer 7 schematic file using Release 16.2 or earlier.
l Migrate the translated *.asmp file into Simplorer (ANSYS Electronics Desktop 2017.2) as an
*.aedt file.

l Set up and run an analysis on the translatedmodel.
l Create reports.

Simplorer Getting Started Guide
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Translating a Legacy Schematic using Release 16.2 or
Earlier

If you want to use your legacy version 7 schematics in Release 18.0 or later projects, youmust first
use Simplorer Release 16.2 or earlier to translate and save the project to make it compatible.

In the following example, you will import a Three-Phase Rectifier .ssh file created in Simplorer ver-
sion 7. The legacy file’s component parameters, simulation setup parameters, and outputs are all
translated into a Simplorer Release 16.2 project, which you can then bring into Simplorer Release
18 for analysis and reports.

Importing the Legacy Schematic into Simplorer Release 16
or earlier
To import a legacy .ssh file:

1. ClickFile>Open.

A standardWindowsOpen dialog box appears.

2. Select Legacy Simplorer Schematic (*.ssh) in the Files of type drop-down list to filter
the window contents.

3. Locate the desired .ssh file (LegacyRectifier.ssh for this example) and clickOK to begin
the import process.

Hint You can also drag the file directly onto the open Simplorer window.

A Legacy Translation Options dialog box appears.
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l The Text Language panel allows you to choose the Target language into which the pro-
ject’s text stringswill be translated. If the target language has no equivalent text for a given
element, you can tell the translation tool either to Ignore elements for which there are no
target language strings; or to useSubstitute strings.

l TheSymbol panel allows you to select whether the symbols in the translated schematic
will beNormal size or five times (5x) normal size. You can also select the symbol Type
and associatedSymbol Language available for display on the translated schematic.

4. For this example, we will use the default values, so leave the settings unchanged and click
OK to begin translation.

TheMessage Manager window informs you of the progress of the translation.

Using Legacy Schematics 8-3

Simplorer 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Simplorer Getting Started Guide

Note l Virtually all of the project’s pre-processing data is translated.
l Optimetrics setup information, including design variables, is not translated.
However, the nominal model is translated.

l Solution data is not translated. Therefore, youmust solve legacy Simplorer projects
again after translation. Existing solution data can be imported either by right-clicking
Analysis in the project tree and selecting Import SDB File from the context menu,
or by selectingSimplorer Circuit> Import SDB File on themainmenu bar.

5. When translation is complete, choose File>Save As and save the translated project with a
name of your choosing before proceeding.

6. In the Project Manager, browse the project tree.

7. Double-click theOptions and TR icons to open theSolution Options and Transient Ana-
lysis Setup dialog boxes, and confirm that the legacy settings have been transferred cor-
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rectly.
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8. SelectSimplorer Circuit>Output Dialog to open theOutputs dialog box and observe
that the defined outputs have been translated.
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Now that you have confirmed that the necessary conditions for finding solutions for the translated
circuit have been correctly set up, the next step is to open the translated schematic in Simplorer.

Opening the Translated Schematic in Simplorer 2017.1 or
Later
To open the translated schematic:

1. Click File>Open.
2. Navigate to the location of the *.asmp project file, and open the file. The File Migration

Required dialog is displayed:
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Select eitherCopy orConvert.

l SelectCopy if you want to create the new *.aedt file and save the original *.asmp file.
l Select Convert if you want to create the new *.aedt file without saving the original *.asmp
file.

3. ClickOK.

The next step is to start an analysis

Starting an Analysis
To start an analysis:

1. Start the analysis (simulation) by selecting theSimplorer Circuit>Analyzemenu com-
mand.

You can also right-click onAnalysis in theProject Manager window and clickAnalyze on
the short-cut menu, or pressF12 on your keyboard to start the analysis.

The simulationmodel is compiled and outputs are calculated. During the simulation run, the
name of themodel is visible in the simulation toolbar in theProgresswindow, and a button
to stop the simulation is available.
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At the end of the simulation, the simulator program remains open so that the simulation can
be run again if any of themodel parameters are changed.

2. After the simulation, the output quantities can be displayed in plots on the sheet or in report
windows. Output data are also saved in a .sdb file (Simplorer Database).

Plotting Simulation Results
Refer to Plotting Rectifier Model Simulation Results for information on plotting simulation results.
Detailed information onGenerating andModifying Reports is also available in the online help.
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